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1 STEFAN'S LAW1 Stefan's LawName Se
tion DateObje
tive
• To dis
over the relationship between temperature and the radiation from a light sour
e.Introdu
tionHeat transfer via radiation is an essential pro
ess in the �ow of energy in the atmosphere so it has a largeimpa
t on 
limate 
hange. Stefan's Law relates the power of a radiation sour
e P (the energy radiatedby an obje
t per time) to T , the absolute temperature of the obje
t. In this experiment, you will makemeasurements of the power emitted from a hot obje
t, namely a Stefan-Boltzmann Lamp, as a fun
tion oftemperature and reveal that fun
tion.ApparatusRadiation Sensor Stefan-Boltzmann Lamp Ammeter (0-3 A) ThermometerOhmmeter Voltmeter (0-13 V) Millivoltmeter Foam insulationPredi
tions(a) The intensity of a light sour
e is the power radiated per area. For your experiment what do you thinkwill happen to the intensity (and the emitted power) of the lamp as the �lament you turn up the voltageand it heats up? Explain your guess.(b) How do you expe
t the intensity (and the power) to be related to the temperature T ? Will it be linear,exponential (eaT ), a power law (T n), or something else?A
tivity 1: Measuring Radiation versus TemperatureTo make these measurements we need a devi
e to measure the power P emitted from the lamp and someway to determine the temperature of the lamp. The radiation sensor in the �gure 
onverts the light fallingon it into an ele
tri
al signal proportional to the power striking the sensor. At the same time the 
urrent�owing through the lamp qui
kly heats the lamp to an equilibrium temperature. The ele
tri
al resistan
e

R of the lamp 
hanges with temperature in a known way so if we determine R we 
an 
orrelate it with thetemperature T .(a) BEFORE TURNING ON THE LAMP, get Trel , the room temperature in degrees Kelvin, (re
all
K =◦ C + 273). Measure Rrel, the ele
tri
al resistan
e of the �lament of the Stefan-Boltzmann Lamp atroom temperature with the ohmmeter on the multimeter. See Charge Measurements in Appendix E:Instrumentation for more details. Enter your results below.
(b) Set up the equipment as shown in Figure 1. The power supply should be 
onne
ted dire
tly to thebinding posts of the Stefan-Boltzmann Lamp. The voltmeter and the ammeter in the 
ir
uit are lo
ated on4



1 STEFAN'S LAWthe power supply. The radiation sensor should be at the same height as the �lament, with the front fa
e ofthe radiation sensor approximately 6 
m away from the �lament. The entran
e angle of the radiation sensorshould in
lude no 
lose obje
ts other than the lamp. The ammeter to measure the 
urrent is the one on thepower supply. Ask you instru
tor to 
he
k the setup before you plug in the power supply and energize theexperiment.
Boltzmann

Stefan−

Lamp

Radiation SensorFigure 1: Equipment setup for Stefan's Law.(
) Use Table 1 to 
olle
t your results. Fill the top row with headings V (volts), I (Amps), P (mV), R(ohms), R/Rrel, and T (K). You 
an also 
reate this table in Ex
el, but make sure you save the �le and printa 
opy to put in your notebook.

Table 1: Data table.(d) Before turning on the power supply turn the voltage dial all the way down (
ounter
lo
kwise). Now turnon the power supply. The voltage reading should be zero.(e) To get the ele
tri
al resistan
e R of the lamp we will measure the voltage V and the 
urrent I throughthe lamp and use Ohm's Law V = IR to extra
t R. The power P will be measured as a voltage from the5



1 STEFAN'S LAWmillivoltmeter on the multimeter atta
hed to the radiation sensor. Set the voltage on the power supply, V ,to the values in the range 1 − 13 V in steps of 1-2 volts. At ea
h voltage setting, re
ord the 
urrent I fromthe ammeter, and P, the reading on the millivoltmeter.IMPORTANT: Make ea
h radiation sensor reading qui
kly. Between readings, pla
e sheets of insulatingfoam between the lamp and the radiation sensor, with the silvered surfa
e fa
ing the lamp, so that thetemperature of the radiation sensor stays relatively 
onstant.A
tivity 2: Extra
ting Stefan's Law(a) Cal
ulate R, the resistan
e of the �lament at ea
h of the voltage settings with Ohm's Law R = V/I.Enter your results in your table.(b) To determine T , the temperature of the lamp �lament at ea
h voltage setting we �rst need to 
al
ulatethe relative resistan
e R/Rrel. Do this 
al
ulation for ea
h entry in your table and enter the results in yourtable. Use this ratio and the 
alibration 
urve in Figure 2 to �nd T . Enter your results in the table.

Figure 2: Calibration 
urve to get the �lament temperature.
6



1 STEFAN'S LAW(
) Plot P versus T and �t it. Print your plot and insert it into your notebook. Re
ord the �t here. Is theplot linear? Does it follow a power law, i.e. P ∝ T n? Does it follow an exponential, i.e. P ∝ eaT ? Re
ordyour answer here.(d) To pre
isely determine the mathemati
al form of the your data, make a semi-log plot, i.e. plot the
ommon log of P versus T . If the data follow an exponential 
urve, then they will form a straight line on asemi-log plot. Show this. Print your plot and insert it into your notebook. Is this plot linear? Do your datalie on an exponential?
(e) Plot the 
ommon log of P versus the 
ommon log of T and �t it. This plot 
an be used to determine ifyour data follow a power law. Show this too. Print your plot and insert it into your notebook. Re
ord the�t here.
(f) How is the slope of the plot you made in part (e) related to the temperature dependen
e?(g) How do your results 
ompare with your predi
tion?
(e) Stefan's Law is usually expressed as P = σAeT 4 where σ is the Stefan-Boltzmann 
onstant, A is thesurfa
e area of the obje
t, and e is a property of the obje
t 
alled the emissivity. From your analysis whatdid you obtain for the exponent on the temperature T ? How does it 
ompare with the expe
ted value?
(h) Colle
t the results from the 
lass, �nd the average and standard deviation, and re
ord them here. Dothe values agree within experimental un
ertainties? Comment on possible sour
es of error.
(i) Clearly state an equation for Stefan's Law.
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A TREATMENT OF EXPERIMENTAL DATAA Treatment of Experimental DataRe
ording DataWhen performing an experiment, re
ord all required original observations as soon as they are made. By�original observations� is meant what you a
tually see, not quantities found by 
al
ulation. For example,suppose you want to know the stret
h of a 
oiled spring as 
aused by an added weight. You must read as
ale both before and after the weight is added and then subtra
t one reading from the other to get thedesired result. The proper s
ienti�
 pro
edure is to re
ord both readings as seen. Errors in 
al
ulations 
anbe 
he
ked only if the original readings are on re
ord.All data should be re
orded with units. If several measurements are made of the same physi
al quantity, thedata should be re
orded in a table with the units reported in the 
olumn heading.Signi�
ant FiguresA laboratory worker must learn to determine how many �gures in any measurement or 
al
ulation arereliable, or �signi�
ant� (that is, have physi
al meaning), and should avoid making long 
al
ulations using�gures whi
h he/she 
ould not possibly 
laim to know. All sure �gures plus one estimated �gure are 
onsideredsigni�
ant.The measured diameter of a 
ir
le, for example, might be re
orded to four signi�
ant �gures, the fourth�gure being in doubt, sin
e it is an estimated fra
tion of the smallest division on the measuring apparatus.How this doubtful fourth �gure a�e
ts the a

ura
y of the 
omputed area 
an be seen from the followingexample.Assume for example that the diameter of the 
ir
le has been measured as .5264 
m, with the last digit beingin doubt as indi
ated by the line under it. When this number is squared the result will 
ontain eight digits, ofwhi
h the last �ve are doubtful. Only one of the �ve doubtful digits should be retained, yielding a four-digitnumber as the �nal result.In the sample 
al
ulation shown below, ea
h doubtful �gure has a short line under it. Of 
ourse, ea
h �gureobtained from the use of a doubtful �gure will itself be doubtful. The result of this 
al
ulation should bere
orded as 0.2771 
m2, in
luding the doubtful fourth �gure. (The zero to the left of the de
imal pointis often used to emphasize that no signi�
ant �gures pre
ede the de
imal point. This zero is not itself asigni�
ant �gure.) (.5264 
m)2 = .27709696 
m2 = 0.2771 
m2In multipli
ation and division, the rule is that a 
al
ulated result should 
ontain the same number of signi�
ant�gures as the least that were used in the 
al
ulation.In addition and subtra
tion, do not 
arry a result beyond the �rst 
olumn that 
ontains a doubtful �gure.Statisti
al AnalysisAny measurement is an intelligent estimation of the true value of the quantity being measured. To arrive at a�best value� we usually make several measurements of the same quantity and then analyze these measurementsstatisti
ally. The results of su
h an analysis 
an be represented in several ways. Those in whi
h we are mostinterested in this 
ourse are the following:Mean - The mean is the sum of a number of measurements of a quantity divided by the number of su
hmeasurements. (In other words, the mean is the same thing as what people generally 
all the �average.�) Itgenerally represents the best estimate of true value of the measured quantity.Standard Deviation - The standard deviation (σ) is a measure of the range on either side of the mean withinwhi
h approximately two-thirds of the measured values fall. For example, if the mean is 9.75 m/s2 and thestandard deviation is 0.10 m/s2, then approximately two-thirds of the measured values lie within the range9.65 m/s2 to 9.85 m/s2. A 
ustomary way of expressing an experimentally determined value is: Mean±σ, or(9.75± 0.10) m/s2. Thus, the standard deviation is an indi
ator of the spread in the individual measurements,8



A TREATMENT OF EXPERIMENTAL DATAand a small σ implies high pre
ision. Also, it means that the probability of any future measurement fallingin this range is approximately two to one. The equation for 
al
ulating the standard deviation is
σ =

√

∑

(xi − 〈x〉)
2

N − 1where xi are the individual measurements, 〈x〉 is the mean, and N is the total number of measurements.% Di�eren
e - Often one wishes to 
ompare the value of a quantity determined in the laboratory with thebest known or �a

epted value� of the quantity obtained through repeated determinations by a number ofinvestigators. The % di�eren
e is 
al
ulated by subtra
ting the a

epted value from your value, dividing bythe a

epted value, and multiplying by 100. If your value is greater than the a

epted value, the % di�eren
ewill be positive. If your value is less than the a

epted value, the % di�eren
e will be negative. The %di�eren
e between two values in a 
ase where neither is an a

epted value 
an be 
al
ulated by 
hoosingeither one as the a

epted value.

9



B INTRODUCTION TO DATASTUDIOB Introdu
tion to DataStudioQui
k Referen
e GuideShown below is the qui
k referen
e guide for DataStudio.

Sele
ting a Se
tion of Data1. To sele
t a data se
tion, hold the mouse button down and move the 
ursor to draw a re
tangle aroundthe data of interest. The data in the region of interest will be highlighted.2. To unsele
t the data, 
li
k anywhere in the graph window.Fitting a Se
tion of Data1. Sele
t the se
tion of data to be �tted. 10



B INTRODUCTION TO DATASTUDIO2. Cli
k on the Fit button on the Graph Toolbar and sele
t a mathemati
al model. The results of the �twill be displayed on the graph.3. To remove the �t, 
li
k the Fit button and sele
t the 
he
ked fun
tion type.Finding the Area Under a Curve1. Use the Zoom Sele
t button on the Graph Toolbar to zoom in around the region of interest in thegraph. See the qui
k referen
e guide above for instru
tions.2. Sele
t the se
tion of data that you want to integrate under.3. Cli
k the Statisti
s button on the Graph Toolbar and sele
t Area. The results of the integration willbe displayed on the graph.4. To undo the integration, 
li
k on the Statisti
s button and sele
t Area.
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C INTRODUCTION TO EXCELC Introdu
tion to Ex
elMi
rosoft Ex
el is the spreadsheet program we will use for mu
h of our data analysis and graphing. It is apowerful and easy-to-use appli
ation for graphing, �tting, and manipulating data. In this appendix, we willbrie�y des
ribe how to use Ex
el to do some useful tasks.C.1 Data and formulaeFigure 3 below shows a sample Ex
el spreadsheet 
ontaining data from a made-up experiment. The experi-menter was trying to measure the density of a 
ertain material by taking a set of 
ubes made of the materialand measuring their masses and the lengths of the sides of the 
ubes. The �rst two 
olumns 
ontain hermeasured results. Note that the top of ea
h 
olumn 
ontains both a des
ription of the quantity
ontained in that 
olumn and its units. You should make sure that all of the 
olumns of your datatables do as well. You should also make sure that the whole spreadsheet has a des
riptive title and yournames at the top.In the third 
olumn, the experimenter has �gured out the volume of ea
h of the 
ubes, by taking the 
ube ofthe length of a side. To avoid repetitious 
al
ulations, she had Ex
el do this automati
ally. She entered theformula =B5∧3 into 
ell C5. Note the equals sign, whi
h indi
ates to Ex
el that a formula is 
oming. The ∧sign stands for raising to a power. After entering a formula into a 
ell, you 
an grab the square in the lowerright 
orner of the 
ell with the mouse and drag it down the 
olumn, or you 
an just double-
li
k on thatsquare. (Either way, note that thing you're 
li
king on is the tiny square in the 
orner; 
li
king somewhereelse in the 
ell won't work.) This will 
opy the 
ell, making the appropriate 
hanges, into the rest of the
olumn. For instan
e, in this 
ase, 
ell C6 
ontains the formula =B6∧3, and so forth.Column D was similarly produ
ed with a formula that divides the mass in 
olumn A by the volume in 
olumnC.At the bottom of the spreadsheet we �nd the mean and standard deviation of the 
al
ulated densities (thatis, of the numbers in 
ells D5 through D8). Those are 
omputed using the formulae =average(D5:D8) and=stdev(D5:D8).C.2 GraphsHere's how to make graphs in Ex
el. For those who've used earlier version of Ex
el but not Ex
el 2007, notethat the lo
ations of some of the menu items have 
hanged, although the basi
 pro
edure is similar.

Figure 3: Sample Ex
el spreadsheet12



C INTRODUCTION TO EXCEL C.3 Making HistogramsFirst, use the mouse to sele
t the 
olumns of numbers you want to graph. (If the two 
olumns aren't next toea
h other, sele
t the �rst one, then hold down the 
ontrol key while sele
ting the se
ond one.) Then 
li
kon the Insert tab at the top of the window. In the menu that shows up, there is a se
tion 
alled Charts.Almost all of the graphs we make will be s
atter plots (meaning plots with one point for ea
h row of data),so 
li
k on the S
atter i
on. You'll see several 
hoi
es for the basi
 layout of the graph. You usually wantthe �rst one, with an i
on that looks like this . Cli
k on this i
on, and your graph should appear.Next, you'll need to 
ustomize the graph in various ways, su
h as labeling the axes 
orre
tly. Everythingyou need to do this is in the Chart Tools menu, whi
h should be visible in the upper right portion of thewindow. (If you don't see the words Chart Tools, try 
li
king on your newly-
reated graph, and it shouldappear.) The most useful items are under the Layout tab, so 
li
k on the word Layout under the ChartTools menu. Here are some things to do under this menu:
• The most important item here is the Axis Titles menu. You 
an use this to add labels to the x and

y axes of your graph, if it doesn't already have them. Edit the text inside of the two axis titles so thatit indi
ates what's on the two axes of your graph and the appropriate units.
• It's probably a good idea to give your graph an overall title as well. The options for doing this areunder Chart Title (not surprisingly).
• If the graph 
ontains only one set of data points, you may wish to remove the legend that appears atthe right side of the graph. After all, the information in the legend is probably already 
ontained inthe title and axis labels, so the legend just takes up spa
e. Go to the Legend menu and 
li
k None todo this.
• Sometimes, you want your graph to 
ontain a best-�t line passing through your data points. To dothis, go to the Trendlinemenu. The easiest thing to do is to 
li
k on More trendline options at thebottom, whi
h will bring up a dialog box with a bun
h of 
hoi
es. Ex
el 
an �t various kinds of 
urvesthrough data points, but we almost always want a straight line, so you'll probably 
hoose the Linearoption. If you want to see the equation that des
ribes this line, 
he
k the Display Equation on 
hartoption near the bottom. Remember that Ex
el won't in
lude the 
orre
t units on the numbers in thisequation, but you should. Also, Ex
el will always 
all the two variables x and y, even though theymight be something else entirely. Bear these points in mind when trans
ribing the equation into yourlab notebook.Sometimes, you may want to make a graph in Ex
el where the x 
olumn is to the right of the y 
olumn inyour worksheet. In these 
ases, Ex
el will make the graph with the x and y axes reversed. There are atleast two ways to �x this problem. Here's the simpler way: before you make your graph, make a 
opy ofthe y 
olumn in the worksheet and paste it so that it's to the right of the x 
olumn. Then follow the abovepro
edure and everything will be �ne. If you don't want to do that, here's another way. Cli
k Sele
t data(near the left-hand side under the Chart Tools menu). In the box that pops up, highlight Series1 and 
li
kEdit. You should see a box that 
ontains entries for Series X values and Series Y values. You want toswap the entries in those two windows. (But really, it's mu
h easier to do it the �rst way.)C.3 Making HistogramsA histogram is a useful graphing tool when you want to analyze groups of data, based on the frequen
y atgiven intervals. In other words, you graph groups of numbers a

ording to how often they appear. You startby 
hoosing a set of `bins', i.e., 
reating a table of numbers that mark the edges of the intervals. You then gothrough your data, sorting the numbers into ea
h bin or interval, and tabulating the number of data pointsthat fall into ea
h bin (this is the frequen
y). At the end, you have a visualization of the distribution of yourdata.Start by entering your raw data in a 
olumn like the one shown in the left-hand panel of Figure 4. Look13



C.3 Making Histograms C INTRODUCTION TO EXCELover your numbers to see what is the range of the data. If you have lots of values to sift through you might
onsider sorting your data is as
ending or des
ending order. To do this task, 
hoose the 
olumn 
ontainingyour data by 
li
king on the letter at the top of the 
olumn, go to Data in the menubar, sele
t Sort, andpi
k as
ending or des
ending. The data will be rearranged in the order you've 
hosen and it will be easierto see the range of the data. For an example, see the middle 
olumn of data in the left-hand panel of Figure4. Now to 
reate your bins pi
k a new 
olumn on your spreadsheet and enter the values of the bin edges.Make sure the bins you 
hoose 
over the range of the data. See the left-hand panel of Figure 4 again for anexample.You now have the ingredients for making the histogram. Go to Data in the menubar, sele
t Data Analysis,and 
hoose Histogram. You should see a dialog box like the one in the right-hand panel of Figure 4. Cli
k inthe box labeled Input Range and then highlight the 
olumn on the spreadsheet 
ontaining your data. Next,
li
k in the box labeled Bin Range and highlight the 
olumn on the spreadsheet 
ontaining the bins. UnderOutput Options, sele
t New Worksheet Ply and give the worksheet a name. Cli
k OK in the Histogramdialog box. You should now see a new worksheet with 
olumns labeled Bin and Frequen
y and a new tabat the bottom with the name you put in the New Worksheet Ply entry. See the left-hand panel in Figure5. Your original data are still available on another worksheet (probably labeled Sheet1). Now highlight theBins and Frequen
y 
olumns by 
li
king and dragging a
ross the 
olumn headings (the A and B at the topof the 
olumns in the left-hand panel of Fig. 5). You 
an then make a graph by following the pro
edure inAppendix C.2 above. The only di�eren
e is that this time you will 
hoose to make a Column graph insteadof a S
atter graph. Make sure you properly label the axes in
luding the units for ea
h quantity. Resultsshould look like the right-hand panel of Figure 5.

Figure 4: Column data and bins (left-hand panel) and dialog box (right-hand panel) for making a histogramin Ex
el. 14



C INTRODUCTION TO EXCEL C.3 Making Histograms

Figure 5: Newly-
reated worksheet (left-hand panel) and �nal plot (right-hand panel) for histogram work-sheet in Ex
el.

15



D VIDEO ANALYSISD Video AnalysisMaking a Movie with �Windows Live Movie Maker�To make a movie, perform the following steps:1. Make sure the 
amera is 
onne
ted to a USB port on your 
omputer. Close all windows, appli
ations,programs, and browsers.2. Cli
k the Start button in the lower-left 
orner of your s
reen and type `movie maker' in the Sear
hprograms and �les box. On
e the sear
h results appear, 
li
k onWindows Live Movie Maker underPrograms. After movie maker starts, 
lose any pop-up windows that may appear.3. Cli
k the Web
am Video button. A web
am video window opens. Enlarge the video frame bydragging the verti
al line on the right side of the video frame.4. Position the 
amera 2-3 meters from the obje
t you will be viewing. Adjust the 
amera height andorientation so that the �eld of view is 
entered on the expe
ted region where the obje
t will move.5. Pla
e a meter sti
k or an obje
t of known size in the �eld of view where it won't interfere with theexperiment. The meter sti
k should be the same distan
e away from the 
amera as the motion you areanalyzing so the horizontal and verti
al s
ales will be a

urately determined. It should also be parallelto one of the sides of the movie frame. Make sure that the meter sti
k is not far away from the 
entralregion of �eld of view, and that it is perpendi
ular to the line of sight of 
amera.6. One member of your group should perform the 
omputer tasks while the other does the experiment.7. To start re
ording your video, 
li
k Re
ord. When you are done, 
li
k Stop.Save the video on your Desktop with a unique name that you 
an easily identify. The video will besaved in Windows Media Video format, i.e. with extension wmv. (Do not save the video as a MovieMaker Proje
t �le.)Analyzing the MovieTo determine the position of an obje
t at di�erent times during the motion, perform the following steps:1. Start up Tra
ker by going to Start → All Programs → Physi
s Appli
ations → Tra
ker. WhenTra
ker starts it appears as shown below. The menu i
ons and buttons that we will use are identi�edby arrows.2. Cli
k the Open Video button on the toolbar (see �gure below) to import your video. After yourvideo is imported, Tra
ker will warn you that the video frames don't have the same time duration.This is okay sin
e Windows Live Movie Maker uses a variable frame rate. Cli
k Close on the warningwindow to ignore Tra
ker's re
ommendation.3. Cli
k the Clip Settings button (see �gure below) to identify the frames you wish to analyze. A 
lipsettings dialog box appears. Here, you only need to identify and set the start and end frames. Leaveeverything else in the dialog box un
hanged. To �nd and set the start frame, drag the player's leftslider to s
an forward through the video, and stop when you get to the �rst frame of interest. Now,the start frame is set and the 
orresponding frame number should be displayed in the dialog box. Ifnot, then 
li
k on the Start Frame in the dialog box, enter the number of the frame (printed in thelower right part of the Tra
ker window), and 
li
k outside the box. Then, 
li
k the Play video buttonto go to the last frame in the video. Next, drag the player's right slider to s
an ba
kward throughthe video to �nd the last frame of interest. Stop when you get to the frame of interest. Now, the endframe is also set and the 
orresponding frame number should be displayed in the dialog box. If not,then 
li
k on the End Frame in the dialog box, enter the number of the frame, and 
li
k outside thebox. Finally, 
li
k the OK button to 
lose the dialog box, and then 
li
k the player's Return buttonto return to the start frame. 16



D VIDEO ANALYSIS
Clip
settings

Import
movie

Axes

Return

Play Sliders

Calibrate

Figure 6: Initial Tra
ker window for video analysis.4. Cli
k the Calibration button (see the �gure) and sele
t the 
alibration sti
k. A blue 
alibrationline appears on the video frame. Drag the ends of this blue line to the ends of your 
alibration metersti
k. Then 
li
k the readout box on the 
alibration line to sele
t it. Enter the length of the metersti
k in this box (without units). For example, if your 
alibration meter sti
k is 1.00 meter long, enter1.00 in the box and then 
li
k outside the box to a

ept the value or hit Return. At this point, you
an right-
li
k the video frame to zoom in for more a

urate adjustment of the ends of the 
alibrationsti
k. Right-
li
k the video again to zoom out.5. Cli
k the Axes button (see the �gure) to set the origin and orientation of the x-y 
oordinate axes.Drag the origin of the axes to the desired position (in most 
ases the initial position of the obje
t ofinterest). Cli
k the video outside the origin to �x the position of the origin. To 
hange the orientation(angle) of the axes, drag the x axis. Cli
k the video to �x the new orientation.6. Cli
k the Create button (see the �gure) to tra
k the obje
t of interest in the video. From the menu of
hoi
es sele
t Point Mass for the tra
k type. Make sure the video is at the start frame, whi
h showsthe initial position of the obje
t of interest. Mark this position by holding down the shift key and
li
king the mouse (
rosshair 
ursor) on the obje
t. As the position is marked, the video automati
allyadvan
es to the next frame. Similarly, mark the position of the obje
t on this and subsequent framesby holding down the shift key and 
li
king the mouse. Do not skip any frames.After marking the position on the end frame, you 
an adjust any one of the marked positions. Advan
ethe video to the frame where you would like to make a �ne adjustment. Right-
li
k the video frame tozoom in and drag the marked position with the mouse.If you would like to tra
k additional obje
ts, repeat the pro
edure outlined here for ea
h obje
t.7. Plotting and Analyzing the Tra
ks: The tra
k data (position versus time) are listed in the TableView and plotted in Plot View se
tions of the Tra
ker s
reen. Cli
k the verti
al axis label of the plotto 
hange the variable plotted along that axis. To plot multiple graphs, 
li
k the Plot button, lo
atedabove the plot, and sele
t the desired number.17



D VIDEO ANALYSISRight-
li
k on a plot to a

ess display and analysis options in a pop-up menu. To �t your data to aline, parabola, or other fun
tions, sele
t the Analyze option. On the Data-Tool window that opensup, 
li
k on the Analyze tab at the top of the plot and 
he
k the Curve Fits box. Sele
t the �t typefrom the Fit Name drop-down menu. Make sure the Auto Fit box is 
he
ked.Note that the 
urve �tter �ts the sele
ted fun
tion to the data in the two leftmost 
olumns of thedisplayed data table. The leftmost 
olumn, identi�ed by a yellow header 
ell, de�nes the independentvariable, and the se
ond leftmost 
olumn, identi�ed by a green header 
ell, de�nes the dependentvariable. So, to �t the data in other 
olumns, their 
orresponding headers must be dragged to the twoleftmost 
olumns.8. Printing and Exporting Data: Tra
k data 
an also be easily exported to Ex
el for further analysisby 
opying the data from the data table to the 
lipboard and pasting into Ex
el. Cli
k the Tablebutton, lo
ated above the data table in the table view se
tion of the main s
reen, and sele
t from thedisplayed list the data you would like to display in the data table. Sele
t the desired data in the tableby 
li
king and dragging, then right-
li
k and 
hoose Copy Data from the pop-up menu. Now, pastethe data into Ex
el. To print out the displayed plot or data table on Tra
ker's s
reen, right-
li
k onthe plot or table and 
hoose Print from the pop-up menu.
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E INSTRUMENTATIONE InstrumentationIntrodu
tionBeing both quantitative and experimental, physi
s is basi
ally a s
ien
e of measurement. A great deal ofe�ort has been expended over the 
enturies improving the a

ura
y with whi
h the fundamental quantitiesof length, mass, time, and 
harge 
an be measured.It is important that the appropriate instrument be used when measuring. Ordinarily, a rough 
omparisonwith a numeri
al s
ale, taken at a glan
e and given in round numbers, is adequate. In
reasing pre
ision,though, requires a more a

urate s
ale read to a fra
tion of its smallest division. The �least 
ount� of aninstrument is the smallest division that is marked on the s
ale. This is the smallest quantity that 
an beread dire
tly without estimating fra
tions of a division.Even at the limit of an instrument's pre
ision, however, a

idental errors � whi
h 
annot be eliminated �still o

ur. These errors result in a distribution of results when a series of seemingly identi
al measurementsare made. The best estimate of the true value of the measured quantity is generally the arithmeti
 mean oraverage of the measurements.Other errors, 
hara
teristi
 of all instruments, are known as systemati
 errors. These 
an be minimized byimproving the equipment and by taking pre
autions when using it.Length MeasurementThree instruments will be available in this 
lass for length measurements: a ruler (one- or two-meter sti
ks,for example), the vernier 
aliper, and the mi
rometer 
aliper.The Meter Sti
kA meter sti
k, by de�nition, is 1 meter (m) long. Its s
aled is divided, and numbered, into 100 
entimeters(
m). Ea
h 
entimeter, in turn, is divided into 10 millimeters. Thus 1 
m = 10−2 m, and 1 mm = 10−1 
m= 10−3 m.When measuring a length with a meter sti
k, di�erent regions along the s
ale should be used for the seriesof measurements resulting in an average value. This way, non-uniformities resulting from the meter sti
kmanufa
turing pro
ess will tend to 
an
el out and so redu
e systemati
 errors. The ends of the sti
k, too,should be avoided, be
ause these may be worn down and not give a true reading. Another error whi
harises in the reading of the s
ale is introdu
ed by the positioning of the eyes, an e�e
t known as parallax.Un
ertainty due to this e�e
t 
an be redu
ed by arranging the s
ale on the sti
k as 
lose to the obje
t beingmeasured as possible.The Vernier CaliperA vernier is a small auxiliary s
ale that slides along the main s
ale. It allows more a

urate estimates offra
tional parts of the smallest division on the main s
ale.On a vernier 
aliper, the main s
ale, divided into 
entimeters and millimeters, is engraved on the �xed partof the instrument. The vernier s
ale, engraved on the movable jaw, has ten divisions that 
over the samespatial interval as nine divisions on the main s
ale: ea
h vernier division is 9

10
the length of a main s
aledivision. In the 
ase of a vernier 
aliper, the vernier division length is 0.9 mm. [See �gures below.℄0 10.00 0 10.051 21.23Examples of vernier 
aliper readings19



E INSTRUMENTATIONTo measure length with a vernier 
aliper, 
lose the jaws on the obje
t and read the main s
ale at the positionindi
ated by the zero-line of the vernier. The fra
tional part of a main-s
ale division is obtained from the�rst vernier division to 
oin
ide with a main s
ale line. [See examples above.℄If the zero-lines of the main and vernier s
ales do not 
oin
ide when the jaws are 
losed, all measurementswill be systemati
ally shifted. The magnitude of this shift, 
alled the zero reading or zero 
orre
tion, shouldbe noted and re
orded, so that length measurements made with the vernier 
aliper 
an be 
orre
ted, therebyremoving the systemati
 error.The Mi
rometer CaliperA mi
rometer 
aliper is an instrument that allows dire
t readings to one hundredth of a millimeter andestimations to one thousandth of a millimeter or one millionth of a meter (and, hen
e, its name). It isessentially a 
arefully ma
hined s
rew housed in a strong frame. To measure obje
ts, pla
e them betweenthe end of the s
rew and the proje
ting end of the frame (the anvil). The s
rew is advan
ed or retra
tingby rotating a thimble on whi
h is engraved a 
ir
ular s
ale. The thimble thus moves along the barrel of theframe whi
h 
ontains the s
rew and on whi
h is engraved a longitudinal s
ale divided in millimeters. Thepit
h of the s
rew is 0.5 mm, so that a 
omplete revolution of the thimble moves the s
rew 0.5 mm. Thes
ale on the thimble has 50 divisions, so that a turn of one division is 1

50
of 0.5 mm, or 0.01 mm.Advan
e the s
rew until the obje
t is gripped gently. Do not for
e the s
rew. A mi
rometer 
aliper is adeli
ate instrument.To read a mi
rometer 
aliper, note the position of the edge of the thimble along the longitudinal s
ale andthe position of the axial line on the 
ir
ular s
ale. The �rst s
ale gives the measurement to the nearest wholedivision; the se
ond s
ale gives the fra
tional part. It takes two revolutions to advan
e one full millimeter,so note 
arefully whether you are on the �rst or se
ond half of a millimeter. The result is the sum of the twos
ales. (See examples below).
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5As with the vernier 
aliper, the zero reading may not be exa
tly zero. A zero error should be 
he
ked forand re
orded, and measurements should be appropriately 
orre
ted.Mass MeasurementThree kinds of instruments will be available to determine mass: a digital s
ale and two types of balan
es.The operation of the �rst instrument is trivial, and so will not be explained here.20



E INSTRUMENTATIONPlease understand that with ea
h of these instruments we are really 
omparing weights, not masses, but theproportionality of weight and mass allows the instruments to be 
alibrated for mass.The Equal-Arm Balan
eThe equal-arm balan
e has two trays on opposite sides of a pivot. The total mass pla
ed on one tray requiredto balan
e the obje
t on the other gives the mass of the obje
t. Most equal-arm balan
es have a slider, aswell, that 
an move along a s
ale and allow for greater pre
ision than the smallest 
alibrated mass available.Typi
ally, this s
ale has 0.5 g divisions.The Triple-Beam Balan
eThe triple-beam balan
e, so-
alled be
ause of its three slider s
ales, 
an be read to 0.1 g and estimated tohalf that. With an obje
t on the tray, the masses of the di�erent s
ales are slid to not
hes until balan
ed.Get 
lose with the larger masses �rst and then �ne-adjust with the smallest slider.Time MeasurementTime measurements in this 
ourse will be made either with a 
omputer or with a stop wat
h. This �rst isout of your 
ontrol.The Stop Wat
hThe stop wat
hes you will use in 
lass have a time range of from hours to hundredths of a se
ond. There aretwo buttons at the top: a stop/start button and a reset button. The operation of these should be evident,although on
e the wat
h is reset, the reset button also starts the wat
h (but doesn't stop it). Please beaware of this feature.Charge MeasurementsThe magnitude of 
harge is among the most di�
ult measurements to make. Instead a number of indire
tmeasurements are undertaken to understand ele
tri
 phenomena. These measurements are most often 
arriedout with a digital multimeterThe Digital MultimeterThe digital multimeters available for laboratory exer
ises have pushbutton 
ontrol to sele
t �ve a
 and d
voltage ranges, �ve a
 and d
 
urrent ranges, and six resistan
e ranges. The ranges of a

ura
y are 100mi
rovolts to 1200 volts a
 and d
, 100 nanoamperes to 1.999 amperes a
 and d
, and 100 milliohms to 19.99megaohms.To perform a DC voltage measurement, sele
t the DCV fun
tion and 
hoose a range maximum from one of200 millivolts or 2, 20, 200, or 1200 volts. Be sure the input 
onne
tions used are V-Ω and COMMON. Thesame is true for AC voltage, regarding range and inputs, but the ACV fun
tion button should be sele
ted.For DC 
urrent 
hoose DC MA (for DC milliamperes), while for AC 
urrent 
hoose AC MA. Your 
hoi
esfor largest 
urrent are 200 mi
roamperes or 2, 20, 200, or 2000 milliamperes. Che
k that the input are
onne
ted to MA and COMMON.There are two 
hoi
es for resistan
e measurement: Kilohms (kΩ) and Megohms (20MΩ). The input 
on-ne
tors are the same as when measuring voltage, namely V-Ω and COMMON. The range swit
hes do notfun
tion with the Megohm fun
tion, but one of the range buttons must be set. The maximum settings forKilohm readings are 200Ω or 2, 20, 200, or 2000kΩ.
21



E INSTRUMENTATIONCalibrating For
e Sensors1. Conne
t for
e sensor to Pas
o interfa
e (in port �A�).2. Open the DataStudio appli
ation that you will use to perform the lab.3. With NO for
e applied to for
e sensor, press TARE button on side of for
e sensor. This sets the sensorto zero. This is the ONLY time you will press the TARE button.4. Cli
k �Setup�.5. Cli
k �Calibrate Sensors�.6. Set 1st 
alibration point to 0 newtons, press upper �Read from sensor� button.7. HOLDING SENSOR VERTICALLY (with hook down), hang 200g from sensor, set 2nd 
alibration pointto 1.96 newtons, press lower �Read from sensor� button.8. Cli
k �OK�. For
e sensor is now 
alibrated for the rest of your experiment. Close �Calibrate Sensors�window, 
lose �Setup� window.9. While still holding the for
e sensor still, press �Start�. Graph should now show a reading of 1.96 N. Press�Stop�.10. Try hanging a di�erent mass from the for
e sensor; press �Start� and 
he
k that it is reading 
orre
tly.
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